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Introduction 

Introduction 

This section provides valuable information about teaching TechnoFuture AI. It 

includes a description of the Teacher Guide, as well as an overview of the 

course. In addition, there are ideas for implementation and technology 

integration.  

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 

How to Use this Guide 

TechnoFuture AI Overview 

Implementation and Technology Integration Ideas SA
MPLE
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How to Use This Guide 

This Teacher Guide contains the following three sections: 

Getting Started: This section contains a course description, as well as ideas for implementation. 

Course Instructions: The course is comprised of six sessions; each focused on a problem-solving 

task that aligns with the course theme. Each session includes assignments that break down the 

task into manageable steps. The components of each session are as follows: 

➢ Overview – an explanation of the session's activities and their purpose.

➢ Materials – a list of handouts, sample files, and teacher resource materials needed to

teach the session.

➢ Teaching Strategies – instructional methods recommended for teaching the activities.

➢ Lesson Plan – a detailed list of each step in the session.

➢ Learning Objectives – a summary of the content knowledge and technical skills taught

throughout the session.

➢ Assignments – a session consists of assignments completed by students. Actions to be

performed on the computer by the student are indicated with a triangle (). Background

information is indicated with a dash (–).

➢ Review – a session review contains matching or multiple-choice questions intended to

review technical knowledge. (answers included).

➢ Skill Review – an additional theme-based assignment intended to apply knowledge of AI

or practice digital literacy or coding skills (includes completed sample).

➢ Extension Activity – an additional activity that relates to the skills presented in the session.

Appendices: This section contains additional information or materials. 

➢ Assessment Tools – a list of reviews, skill reviews, marking sheets, and checklists.

➢ Contact Information – how to contact TechnoKids Inc. for curriculum support.
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TechnoFuture AI Overview 

In this course, students create an interactive 'Choose Your Own Adventure' story set in a world 

shaped by artificial intelligence. They start by researching emerging technologies and record 

their findings with a Word organizer. They transform these facts into PowerPoint slides that 

immerse the reader directly in the action. Using AI tools, students generate images, 3D models, 

and music illustrating futuristic homes, transportation, and workplaces. To bring this reality to life, 

they program a virtual tutor in Scratch that invites reader participation in the sci-fi narrative. 

Extension activities feature designing a gadget user manual, coding a virtual pet, and 

embarking on a time-travel tour. Through TechnoFuture AI, students explore the practical and 

ethical use of current AI technologies while imagining tomorrow. 

Students complete the following tasks: 

➢ In session 1, students take on the role of futurists, imagining what tomorrow might look

like. They begin by exploring artificial intelligence and discovering how it is already part

of their everyday lives. Then they watch a future-themed video that brings the possibilities

to life. Using an AI-powered research tool, students investigate emerging innovations and

record their discoveries in a Word organizer. Finally, they team up with classmates to

build a bubble map using PowerPoint packed with creative inventions for homes,

schools, and workplaces of the future.

➢ In session 2, students kick off their 'Choose Your Own Adventure' sci-fi story by inventing a

futuristic gadget designed to help teens get ready for school. They begin by imagining

the purpose, appearance, and user interface of the device. Then, they bring their

invention to life using an AI Image Generator, crafting visual representations through

descriptive text prompts. After creating their gadget, students write the opening scene of

their story, which starts with the reader waking up in a high-tech home of the future. They

include their illustrated gadget on the slide. An optional extension activity has students

explore ethical questions related to the use of AI-generated artwork.

➢ In session 3, students continue developing their interactive story by offering readers two

unique ways to travel to school. They start by designing a futuristic vehicle such as a

hover scooter or teleporting bubble based upon an image found online that has a

Creative Commons license. Using a 3D AI modeling tool, they transform the flat image

into a 3D object that spins, flips, and twirls in any direction. Next, they create a slide that

illustrates the journey from home to school using their invention. During a gallery walk,

classmates explore each other's creations and select a second futuristic vehicle to

include in their story. By sharing 3D models and slide content, students give readers

engaging, imaginative choices. As an optional extension, students explore AI

cybersecurity systems that could protect school data.
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➢ In Session 4, students imagine what schools of the future might look like. They

investigate how computer vision and artificial intelligence could transform

learning environments and classroom experiences. Next, students design a school

day itinerary and incorporate it into their 'Choose Your Own Adventure' story,

featuring high-tech learning activities, such as a futuristic quiz. To simulate an AI-

powered testing environment, students use Scratch to create a True or False quiz.

The program allows users to respond by swiping their hands over virtual buttons,

mimicking gesture-based input. The quiz provides real-time feedback by

automatically checking answers and displaying results. Once complete, students

add a link to the quiz in their interactive itinerary so readers can take the test as

part of the story. As an optional extension, students can watch a TED Talk on

extended reality (XR) or create a history assignment that includes a 3D

population map, generated with the help of AI tools.

➢ In session 5, students finish their 'Choose Your Own Adventure' story. As the school day

ends, the reader faces another choice: head to work or join friends for a futuristic activity.

For the 'Work in the Future' path, students design a SmartArt graphic that outlines a to-do

list for a part-time job a teen might have in tomorrow's world. For the 'Entertainment in the

Future' path, students use a Generative AI tool to create an original background song

that captures the scene's mood. Once both options are complete, students write an

ending. As an optional extension, students can enhance their stories by producing AI-

generated music for all scenes or by watching a TED Talk on AI and creativity.

➢ In session 6, students prepare to unveil their imaginative, futuristic worlds to readers. They

begin by testing the story’s flow, ensuring that each choice leads to the correct slide.

Next, they enhance the storytelling experience by applying advanced animation

techniques to keep readers fully engaged. Once their interactive story is complete,

students share their 'Choose Your Own Adventure' file with others. They then read a

classmate’s sci-fi story and leave a comment highlighting their favorite part. To wrap up

the course, students reflect on their creative journey and the skills they have developed

along the way. As an optional challenge, they can explore accessibility tools and apply

design suggestions to make their story more inclusive.
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Implementation and Technology Integration Ideas 

In TechnoFuture AI, students explore emerging and futuristic artificial intelligence (AI) 

technologies to create an interactive science fiction 'Choose Your Own Adventure' story. The 

course blends digital storytelling with AI exploration, using Generative AI tools to add images, 3D 

models, and music. Along the way, students examine the benefits, challenges, and ethical use 

of AI. Flexible activities let you choose the best approach for your class. 

Ideas for Implementation 

STEM or Computer Science Class: This course is ideal for a computer science class. It blends 

artificial intelligence concepts, Generative AI tools, and Scratch coding into a single unit. 

Students explore the real-world impact of AI on daily life, transportation, learning, work, and 

entertainment. They do this by creating a digital story in PowerPoint that imagines tomorrow. To 

engage the reader, they include a link to a virtual tutor game they design in Scratch. 

Artificial Intelligence Unit: If you want to solely teach artificial intelligence, TechnoFuture AI 

includes assignments and extension activities you can use without the digital storytelling 

component. In Session 1 students are introduced to AI and explore its history, benefits, and risks. 

Through Ted Talks and hands-on activities, you can also explore topics such as: 

• AI and intellectual property rights (Session 2 Extension Activity)

• Cybersecurity (Session 3 Extension Activity)

• Computer vision and extended reality (Session 4 Extension Activity)

• Voice cloning and creativity (Session Extension Activity)

You can also concentrate on Generative AI tools to: 

• Research (Assignment 5-6)

• Produce images (Assignment 9-10)

• Create 3D models (Assignment 14)

• Generate and analyze data (Session 4 Extension Activity)

• Compose music (Assignment 27)

Coding Activity: You can use TechnoFuture AI to develop advanced block coding skills. In 

Session 4, students use Scratch to create a futuristic quiz that simulates augmented reality by 

projecting the 'real world' onto the Scratch stage. This session can be taught as a stand-alone 

unit (Assignments 17, 19-24). The project combines video sensing, conditional logic, variables, 

and broadcasting. A virtual tutor poses 'True' or 'False' questions, and users respond by swiping 

their hands over virtual buttons. Session 4 also offers an optional challenge by having students 

design a virtual pet that reacts to motion. 

Media Arts Unit: TechnoFuture AI offers rich, creative elements that align well with a digital arts 

course. Teachers can choose to place less emphasis on the AI concepts and coding by 

removing some of the assignments in Session 1 and Session 4. Instead, highlight the multimedia 

aspects including generating unique digital art (Session 2), designing 3D models (Session 3), 

composing original music (Session 5), and animating story content (Session 6). 

Digital Citizenship Outcomes: This course supports digital citizenship by guiding students in the 

responsible use of Generative AI. Through activities on effective prompt creation, school AI 

policies, and transparency, learners develop digital responsibility. Students work with AI tools 

ethically, gaining an understanding of copyright, Creative Commons licensing, and usage rights. 
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Technology Integration Suggestions 

TechnoFuture AI is a STEM-focused course that challenges students to think critically about the 

potential of artificial intelligence through digital storytelling. This cross-curricular unit goes beyond 

AI, integrating skills from computer science, language arts, mathematics, visual arts, music, and 

media arts. 

• Computer Science: TechnoFuture AI combines artificial intelligence, Generative AI tools,

and coding to deliver a rich computer science learning experience. It addresses key

outcomes such as algorithms and programming, data analysis, and the societal impacts

of computing. The course places strong emphasis on exploring both the benefits and risks

of emerging and future technologies.

• Language Arts/English: This course can be adapted for English classes with a focus on

digital storytelling. Students follow the stages of the writing process: planning and

organizing ideas, crafting engaging second-person point-of-view narratives, refining their

text with AI-powered suggestions, publishing their work, and reflecting on the experience.

The integration of emerging technologies is optional, giving students the freedom to

create science fiction stories that showcase imaginative ideas. In addition to creative

writing, students strengthen their descriptive writing skills through prompt engineering.

• Mathematics, Data Analysis, and Problem-Solving: In Session 4, students develop data

management skills by analyzing future population trends through a stand-alone activity.

After generating data using an AI tool, they open a spreadsheet in Excel and format it

into a table. Using Excel’s 3D Maps feature, they create geographic visualizations and

customize the display. This activity encourages critical thinking as students interpret the

data and generate meaningful questions.

• Visual Arts: Generative AI tools are used to produce unique images and 3D models for

digital stories. This hands-on process lets students apply artistic techniques, explore

different visual styles, and create original works that bring their ideas vividly to life.

• Music: Students explore the creative side of music. They use AI tools to compose original

soundtracks that match the mood and theme of each slide in their digital story. To

support this, the Resource folder includes a collection of free AI music generators, each

accompanied by detailed, easy-to-follow instructions.

• Media Arts: As part of a media arts program, TechnoFuture AI integrates creative

expression with technical skills enabling students to communicate ideas effectively. The

course explores visual storytelling through interactive media, design principles, animation,

and emerging technologies.SA
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Session 2 Illustrate the Home of the Future 

Session 2 Illustrate the 
Home of the Future

In this session, students kick off their 'Choose Your Own Adventure' sci-fi story by 

inventing a futuristic gadget designed to help teens get ready for school. They 

begin by imagining the purpose, appearance, and user interface of the 

device. Then, they bring their invention to life using an AI Image Generator, 

crafting visual representations through descriptive text prompts. After creating 

their gadget, students write the opening scene of their story, which starts with 

the reader waking up in a high-tech home of the future. They include their 

illustrated gadget on the slide. An optional extension activity has students 

explore ethical questions related to the use of AI-generated artwork. 

Assignment 8 Generate a Title Slide Using an AI Designer 

Assignment 9 AI Image Generation and Text Prompting 

Assignment 10 Invent a Futuristic Gadget for Teens 

Assignment 11 Wake Up in the Home of the Future 

Assignment 12 Control the Story Using Zoom 

Session 2 Review About AI Image Generation 

Session 2 Skill Review Create a Gadget User Manual 

Session 2 Extension Activity Discuss the Ethics of AI Artwork 
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Session 2 Getting Started 

Overview 

In this session, students kick off their 'Choose Your Own Adventure' sci-fi story by inventing a 

futuristic gadget designed to help teens get ready for school. They begin by imagining the 

purpose, appearance, and user interface of the device. Then, they bring their invention to life 

using an AI Image Generator, crafting visual representations through descriptive text prompts. 

After creating their gadget, students write the opening scene of their story, which starts with the 

reader waking up in a high-tech home of the future. They include their illustrated gadget on the 

slide. An optional extension activity has students explore ethical questions related to the use of 

AI-generated artwork. 

Materials 

• Microsoft PowerPoint

• Research Organizer or Bubble Map (from Session 1)

• AI Images folder (Assignment 10)

• Invent a Gadget Planning Sheet (Assignment 10)

• Imagine Tomorrow sample (optional)

• Session 2 Review: About AI Image Generation (optional)

• Session 2 Skill Review: Create a Gadget User Manual (optional)

o User Manual Sample

• Session 2 Extension Activity: Discuss the Ethics of AI Artwork (optional)

o https://www.ted.com/talks/ed_newton_rex_how_ai_models_steal_creative_work_and_what_to_do_about_it

Teacher Preparation 
(Refer to the Preparing to Teach section of this course for instructions) 

• Verify students have access to their completed research (Assignments 6 and 7) about

emerging AI technologies.

• Make the FutureAI folder available to students. It has the AI Images folder which includes

instructions and links to free AI Image Generators.

• Refer to the Title Slide and Home of the Future slide in the Imagine Tomorrow sample.

IMPORTANT! 

In this session, students will use an AI Image Generator to create a futuristic gadget for their story. Since 

image generation is time-consuming and can strain the school's network, only a small group of students 

should generate images at any one time. To avoid technical issues, follow this rotation strategy: 

• At the start of the session, choose 4–5 students to complete Assignments 9 and 10 first (this

includes generating their image). Once they finish, they should notify the teacher. Then, they

can move on to Assignments 8, 11, and 12.

• All other students will work through the assignments in order, starting with Assignment 8. They will

complete Assignment 10 by planning their invention but will not generate an image yet. Instead,

they will move ahead to Assignments 11 and 12.

• As soon as a student finishes generating their image, the teacher will select the next student who

has their Assignment 10 text prompt ready. That student may then generate their image.

• Continue this rotation until all students have created an image of their futuristic gadget.

Additional strategies for managing image generation are available in the Teacher Strategy section. 
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Teaching Strategy 

In this session, students create the beginning of their digital story. Explain session scenario: 

In this session, you start building your own 'Choose Your Own Adventure' 

story using PowerPoint. To prepare your digital book, you first explore how 

keywords influence the themes suggested by an AI-powered design tool. 

Next, you expand your prompt engineering skills by using an AI image 

generator to invent a futuristic gadget your main character will use to get 

ready for school. You then write the opening scene of your story. To make 

the setting and events feel believable you need to blend real-world emerging 

technologies with imaginative futuristic ideas. Think about how AI could help make 

everyday tasks faster or more convenient. Once your 'Home of the Future' slide is 

complete, use the Zoom tool to let readers navigate through the story using buttons. 

What might a home of the future look like? How could AI make morning routines easier? 

Assignment 8 Generate a Title Slide Using an AI Designer 

In this assignment, students create a Title Slide for their 'Choose Your Own Adventure' story that 

acts as the digital book cover. They use an AI-powered design tool to generate a theme based 

on keywords. Afterwards, they modify the color, font, and background styles. 

TECH TIP: If Designer is turned ON by default all new presentations may have a theme 

automatically applied. If this happens: 

• From the File menu, select Options. Click General.

• Remove the checkmark on Automatically show me design ideas. Click OK.

Assignment 9 AI Image Generation and Text Prompting 

In this assignment, students learn tips for writing clear text prompts for AI image generation. They 

study a sample description and answer questions. Draw student's attention to the details that are 

included such as the art style, setting, time of day, subject, action, focal point, and adjectives. 

Introduce the following terms: 

• generative AI: Generative AI refers to algorithms that interpret user input such as written

descriptions or visual prompts to create new, original content, including text, images,

animations, video, and audio.

• AI image generation: AI image generation refers to the process where artificial

intelligence creates a new picture based on text or visual prompts that describe the

output.

• text prompt: A text prompt is a written description of the image.

• visual prompt: A visual prompt is an image that a generative AI system can use as a

reference to produce a new creation based upon the original's content or style

Session 2 Extension Activity: Discuss the Ethics of AI Artwork 

Watch a Ted Talk about intellectual property rights and AI training 

models. Compare the pros and cons of generative AI on creators. 
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Assignment 10 Invent a Futuristic Gadget for Teens 

 

In this assignment, students invent a futuristic gadget to include in the opening of their story. It 

helps the character get ready for school in the morning. To start, they answer questions to 

organize their ideas including the type of gadget, gadget name, function, appearance, and 

user interface. Afterwards, students write a text prompt that clearly describes the invention. 

Remind students that free AI Image Generators have limits on the number of complimentary 

generations therefore they need to be certain their description is specific. 

 

Tips for Using AI Image Generators: 

• Need instructions? Refer to the AI Images folder in Student Resources for handouts 

explaining how to use popular AI Image Generators. 

• At your limit? Switch to a different AI Image Generator, when an image cap is reached. 

• Want more AI tools? Refer to the blog article for a list of free AI Image Generators. 

• Get expert advice: BEFORE generating an image, use ChatGPT or Copilot to improve 

your description. For example, I would like to make an image. How could I improve this 

description, "type in your prompt". 

• Small groups only! Restrict the number of students generating images at one time. 

• Are computers freezing? If the school network becomes sluggish when generating 

images, have students complete this task at home. 

• Want to make changes? Most AI Image Generators cannot edit a generated image. 

Instead, they use the requested modifications to create an entirely new image. 

• Give credit: Some AI Image Generators will generate a citation. Just ask, "Can you give 

me the citation for this image?" 

 

  
 

Assignment 11 Wake Up in the Home of the Future 

 

In this assignment, students write the opening of their sci-fi 'Choose Your Own Adventure'. The 

story is written using second person narrative, which means that the reader is the main 

character. You may wish to show the Imagine Tomorrow sample to examine the use of the 

pronoun 'you'.  

 

Students must include two AI devices that help the reader get ready for school in the morning. 

One is their futuristic gadget from Assignment 10. The other they can select from the Home 

category of their research organizer or bubble map created in Session 1. To support learners, as 

a class, generate a list of steps to get ready for school. Then beside each one, write an 

emerging or futuristic technology that would make the task more convenient. Invent names! 

 

For example: 
Activity Emerging Technology Futuristic Technology 

wake up LumoGlass – change tint on windows RiseSync – adjust light using breathing pattern 

shower MyTemp – recall water temperature AquaPod – detect mood to set fragrance 

get dressed SmartMirror – virtually try on outfits FabricMorph – modify the color of clothing 

breakfast FridgeAI – post recipes from food inside Cheftronic – 3d print breakfast food 

pack bag ReadyGo – scan bag and list contents PackPal – scans schedule then packs items 
  

Session 2 Skill Review: Create a Gadget User Manual 

 

Have students practice their PowerPoint skills by creating a manual for their 

futuristic gadget that includes user instructions as well as a troubleshooting tips. 
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Assignment 12 Control the Story Using Zoom 

In this assignment, students add a button to the digital book cover to have the reader control 

the story navigation. They learn how to set slide advancement by restricting mouse clicks from 

displaying the next slide. They then use the Zoom tool to add a thumbnail of the 'Home of the 

Future' slide, that displays the opening of the story. Optional instructions explain how to modify 

the image into an icon. They then test the story to make sure the navigation is working properly. 

Introduce the following tool: 

• Zoom: Zoom adds an interactive button that links directly to a specific slide which

smoothly transitions into view when clicked.

Lesson Plan 

Assignment 8 Generate a Title Slide Using an AI Designer 

• What is PowerPoint Designer?

• Create a title slide to act as a digital book cover.

• Experiment with keywords in the title to generate themes using Designer. Select one.

• Modify the color, font, and background style of the selected theme.

• Edit the title if necessary to remove unwanted keywords. Save the story.

Assignment 9 AI Image Generation and Text Prompting 

• What is an AI Image Generator?

• Read prompt engineering tips for image generation.

• Analyze the text prompt and output to identify the descriptive words.

Assignment 10 Invent a Futuristic Gadget for Teens 

• Invent a gadget including the type, name, function, appearance, and user interface.

• Plan a text prompt to describe the futuristic gadget.

• Apply skills to use an AI Image Generator to create an illustration of the futuristic gadget.

Assignment 11 Wake Up in the Home of the Future 

• Plan the two AI devices you intend to use at the beginning of the story.

• Open the story in PowerPoint. Insert a new slide with the Two Content layout.

• Write about getting ready for school using high-tech devices.

• Insert a picture of the futuristic gadget created in Assignment 10.

• Use Designer to improve the layout of the slide. Save the changes.

Assignment 12 Control the Story Using Zoom 

• Open the story in PowerPoint.

• Prevent the title slide from advancing when the mouse is clicked.

• Use Zoom to add a thumbnail on the title slide that links to the 'Home of the Future' slide.

• Modify the thumbnail to change it into an icon. (optional)

• Test the story to verify that the story only advances when the button is clicked.

• Save the changes.
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Learning Objectives 

Content Knowledge | Digital Storytelling 

• plan the emerging and futuristic AI devices to include in the story events

• write using second-person point of view to engage the reader as the main character

• blend AI technologies into the plot to create a believable science fiction story

• illustrate the story events using an original AI-generated image

Artificial Intelligence 

Impact of Artificial Intelligence on Society 

• describe emerging and futuristic AI technologies that could be used in homes

• invent a futuristic gadget that makes a morning routine faster or more convenient

• evaluate how AI Image Generators impact personal creativity and artists (optional)

• evaluate the pros and cons of AI image generation (optional)

Generative AI | Image Generation 

• define terminology: generative AI, AI image generation, text prompt, visual prompt

• identify descriptive words in a text prompt used to generate an image

• write a clear text prompt to describe an image including details such as setting,

subject, style, color scheme, mood, and/or focal point

• generate an image from a text prompt using an AI Image Generator

• refine an image using suggestions from an AI Image Generator

• download an AI-generated image

Presentation Skills 

Slide Design 

• trigger AI-generated themes using keywords in the title box

• apply a theme or slide layout suggested by Designer, an AI-powered tool

• modify the color, font, or background style of a theme

• apply a slide layout

Text Formatting 

• remove the bullets from text

Slide Objects 

• insert a saved image from a device

• swap an image with a symbol from an icon library

Slide Transitions and Animation 

• control slide advancement by restricting 'on mouse click'

• use zoom to link to a specific slide using a slide thumbnail or icon

Applied Technology 

• design a title slide that acts as a digital book cover for the story

• write the beginning of a non-linear 'Choose Your Own Adventure' story

• test the navigation of a digital story and fix any errors

• design a user manual for a futuristic AI device (optional)

• analyze a Ted Talk on AI Image Generators and intellectual property rights (optional)
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Assignment 8 Generate a Title Slide Using an AI Designer 

In this assignment, you create the Title Slide for your sci-fi 'Choose Your Own 

Adventure'. You will use an AI-powered design tool to generate an interesting digital 

book cover. Your decisions will create a consistent theme that will be applied to all 

slides in your story. 

What is PowerPoint Designer? 

PowerPoint Designer uses artificial intelligence to instantly transform the visual design of slides. For 

Title Slides, it analyzes keywords in the title text box to recommend a matching image, font 

theme, and color palette. On other slides, it evaluates the text and images to suggest layout 

improvements to increase visual appeal. 

Design a Title Slide That Fits a Science Fiction Story 

1. Open PowerPoint. Select Blank Presentation.

2. Type in a story title such as Future AI or come up with your own idea.

3. 
In the subtitle box type: In this story, you are the main character. Your choices control what

happens. Click the button to begin your adventure.

 TITLE SUGGESTIONS: 

 Imagine Tomorrow Future Me 2099 Futuristic Fun 

 Dream of the Future Digital Teen Diary Time Travel AI Teen 

 Hi-Tech Adventure My AI Teen Life Robot World Control Your Destiny 

Apply a Theme Using Designer For a Science Fiction Story 

4. Select a design option:

a. From the Design tab, click Designer to generate suggestions.

b. Add keywords to the title box to change the design ideas.

 KEYWORD SUGGESTIONS: (you will delete them later) 

 book digital artificial intelligence cubist gradient 

 novel cyber science fiction watercolor style 

 comic robot computer chips geometric theme 

 diary futuristic color word (e.g., red) pattern genre 

 school sensors landscape texture mode 

c. Click on a design idea you like.

 TIPS: 

• Add keywords and then click Designer to generate a new list of suggestions.

• Do not click on a design theme unless you are 100% sure it is the one you want.

• If you select a design theme but do not like it, instantly press CTRL + Z to remove it.
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Modify the Design Theme 

5. Click on Designer again. It will suggest slide layouts using the theme. Pick one.

6. Customize the color, font, and background style:

a. From the Design tab click the Variants arrow.

b. Select Colors. Pick a theme.

You may not notice the color 

scheme if your title slide is 

missing a graphic element. 

c. Select Fonts. Pick a theme.

d. Select Background Styles. Pick a style.

Some design themes do not 

have background style options. 

Edit the Title, Then Save the Story 

7. Delete any extra words added to the title. For example:

8. Save your story in your student folder.
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Assignment 9 AI Image Generation and Text Prompting 

In this assignment, you learn about AI image generation and tips for creating images based on a 

clear description. This will prepare you for the next assignment, when you will invent a futuristic 

gadget for your 'Choose Your Own Adventure' story. The character will use it to get ready for 

school in the morning. 

What is AI Image Generation? 

You are going to use Generative AI throughout this course. Generative AI refers to algorithms 

that can create new content based on user input. There are many types of AI generators 

including tools that can create original text, images, animations, video, and audio. 

The first type of Generative AI you are going to use is AI image generation. AI image generation 

refers to the process where artificial intelligence creates a new picture based on text or visual 

prompts that describe the output.  

• A text prompt is a written description of the image.

• A visual prompt is a reference image that can be used to illustrate the idea, helping to

set the tone, color, style, and context.

When you use an AI Image Generator: 

• You type a description of the image.

• You can train the AI to know what you

like by giving the output a thumbs up.

• You can then improve the image

using ideas provided by the AI tool.

• When you get an image you like, you

can save it on your device.

Most free AI Image Generators restrict use. 

For this reason, it is a good idea to plan your prompt, so you don't waste your daily limit. 
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Prompt Engineering Tips for Image Generation 
 

AI image generators have been trained using millions of pictures. This training enables the AI to 

recognize patterns and relationships to create original images that match the prompts. 

 

To create an image that matches your idea, you need a text prompt that is clear, detailed, and 

specific. Below are some prompt engineering tips: 

 

 
 

Basic Tips: 

• Keep ideas organized: Use full sentences or a short list of features. 

• Focus on one main idea: Choose one scene or object and describe it well. 

• Be specific: Include key information about the setting, subject, action, and mood. 

o Setting: Describe the location, background, weather, season, or time of day. 

o Subject: Describe an object such as the size, shape, color, or material. Or describe 

the person such as gender, age, race, hair style, or clothing. 

o Action: Describe the activity, movement, or purpose. 

o Mood: Describe the vibe such as whimsical, cheerful, mysterious, chaotic, or calm. 

• Set the style: Pick a visual style such as steam punk, cartoon, anime, pop art, or realistic. 

• Use descriptive words: Use adjectives such as giant, metallic, sleek, futuristic, or glowing.  

• Refine the image: Tweak the design with the ideas provided or say what you don't like. 

IMPORTANT! When you refine the image, many AI Image Generators cannot directly edit the 

original file. Instead, an entirely new image is created using the suggestions. 

 

 

Advanced Tips: 

• Define the lighting: Change the feel of an image by describing the lighting or shadows. 

• Specify the palette: Outline the colors such as pastel, monochrome, neon, or earthy. 

• Add perspective: Set the camera angle like top-down, close-up, or over-the-shoulder. 

• Highlight the focal point: Specify the main element to set the focus of the image. 
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Analyze the Text Prompt and the Image Created by the AI Image Generator 

I'll try to create that anime-style image of a modern bedroom with the futuristic 

TechnoCloset on a sunny morning. The image will appear below shortly! 

OpenAI. (2025). Anime-style image of a modern bedroom with a futuristic TechnoCloset gadget [AI-generated image]. Microsoft Copilot. 

https://copilot.microsoft.com 

1. What words are used to describe the setting?

a. futuristic gadget

b. modern bedroom

c. teenage girl

2. What words describe the time of day?

a. morning

b. night

c. dinner

3. What is the style of the image?

a. cartoon

b. sketch

c. anime

4. Does the output have the name of the gadget?

a. yes, the name is TechnoCloset

b. no, it has no name

5. What can the gadget do?

a. 3d print breakfast food

b. pack school bag

c. 3d print clothes

Make an image in the anime style of a modern bedroom that has a futuristic 

closet gadget, called TechnoCloset. The gadget can 3d print clothes. It has 

metallic buttons to pick the type, shoes, color, or fabric. The focal point 

should be the gadget. It is morning and it is a sunny day. 
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Assignment 10 Invent a Futuristic Gadget for Teens 

In this assignment, you get ready to write the opening of your sci-fi 'Choose Your Own 

Adventure'. It all starts with the character waking up in a high-tech home of the future. They 

need to get ready for school. 

 

What futuristic tool or device helps your character get ready in the morning? 
 

 
 

You have already researched emerging technologies to include in your story. Maybe the fridge 

suggests a smoothie based on what’s inside. Or maybe smart sensors adjust the window glass so 

the reader can see outside. Now it is time to go beyond existing AI and use your imagination to 

invent a futuristic AI gadget. You will bring this technology to life using an AI image generator.  

 

Here is what you will do: 

• Invent a futuristic gadget that makes a morning routine faster or more convenient 

• Plan a prompt that clearly describes your gadget. 

• Use an AI Image Generator tool to create your invention.  

• Save the image. It will be added to your story in the next assignment. 

 

Invent a Futurisitc Gadget for Teens 
 

1. What is the type of gadget?  Description Ideas 

 3D clothes printer   handheld 

    desktop 

2. Gadget Name:   TechnoCloset   wall-mounted 

    curvy 

3. What does the gadget do?   boxy 

 3d print clothes to allow teens to create a custom outfit   modular 

    moving parts 

4. What does the gadget look like? (e.g., size, shape, material)   metallic 

 large, curvy, modern-looking closet with a touch screen   plastic 

    carbon fiber 

5. What is the user interface like?   translucent 

 List three buttons, sliders, or screen options the gadget should include:   hologram 

 • size   voice-activated 

 • color   gesture-based 

 • fabric   projection 
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Plan a Prompt that Clearly Describes the Invention 

6. Write a description of the image. The key is to describe what is essential.

Pick an option. You can fill-in-the-blanks, list the features, or draft your own text prompt.

OPTION 1: Fill-in-the-Blanks to Plan a Text Prompt 

Make an image in the anime style of a teenagers' futuristic bedroom, with a robot butler 

describe the setting 

In the room is a futuristic gadget of a 3D clothes printer called TechnoCloset . 

gadget type gadget name 

The gadget can make custom outfits for teens . 
purpose of the gadget 

The gadget is a large, curvy, modern-looking closet with a touch screen . 
describe the gadget's appearance 

The gadget has options to pick size, color, and fabric . 
list the button, slider, or screen options 

OPTION 2: Make a List of Image Features 

Make an image I can use for a futuristic story. The scene should have the following features: 

background: teenager's bedroom with a glowing bed and robot butler 

gadget: 3D clothes printer called TechnoCloset that creates custom outfits for teens 

gadget description: large, curvy, modern-looking closet with a touch screen 

gadget user interface: options to pick the size, color, and fabric 

style: anime 

color scheme: vibrant 

mood: cheerful 

OPTION 3: Plan Your Own – be specific, not long 

Text Prompt Suggestions: 

Style Color Schemes Mood Gadget Adjectives 

anime monochromatic dreamy cybernetic synthetic 

cyberpunk soft pastels futuristic customizable modular 

steampunk warm tones mysterious holographic transparent 

fantasy cool tones serene gleaming sleek 

vector art earth tones otherworldly glossy glowing 

cartoon jewel tones cheerful textured chrome 

comic book grunge cosmic bio-integrated compact 

gothic vibrant gritty voice-activated decayed 

art deco neon quirky high-tech lightweight 

watercolor solar flare utopian hovering secure 
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Use an AI Image Generator to Create the Invention 

 Open a web browser.

 Pick an AI Image Generator. You may need to create an account or sign in.

AI Image Generators 

If you are using a free version, there may be a cap on how many images you can create. If 

that happens, just switch to another tool from the list. 

ChatGPT https://chatgpt.com/ 

Copilot https://copilot.microsoft.com/ 

Gemini https://gemini.google.com/app 

Other Refer to the options in the AI Images folder. 

OPTIONAL: Refer to AI Images handouts in the Student Resources folder for instructions and tips 

on how to use different AI tools. 

 Type the text prompt to create an image of the gadget. For example:

TIPS: 

• The reader is the main character in the story. For this reason, you may not want to include an

image of a person.

• You can crop the image later to remove unwanted parts.

• Some image generators spell words incorrectly. Try putting button names in "quotes".

• Most free image generators cannot edit an existing image but instead will make a new one.

• Try different AI generators. These images were all made using the exact same prompt!

ChatGPT Copilot Gemini Canva AI 

Crop this type of image later 

to remove the person. 

Ask to recreate the 

image with no person. 

Describe the objects in 

the room. 

Include morning or sunny to 

create a bright image. 

 Save the image.

Make an image in the anime style of a teenager's futuristic bedroom with a 

glowing bed and robot butler. Against the wall in the room is a futuristic 

gadget of a 3D clothes printer called TechnoCloset. The gadget makes 

custom outfits for teens including clothes, shoes, and accessories. The 

gadget is a large, curvy, modern-looking closet with a touchscreen. The 

gadget has options to pick "size", "color", and "fabric". 
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Assignment 11 Wake Up in the Home of the Future 

In this assignment, you write the first event in the sci-fi 'Choose Your Own Adventure'. The reader 

wakes up in a high-tech home of the future. They need to get ready for school.  

 

Here is what you will do: 

• Write the beginning of the story as if the reader is the main character. ('You wake up.')  

• Insert the image of the futuristic invention. 

• Improve the slide layout using PowerPoint Designer. 

 

 
 

Make a Plan With Two AI Technologies Futuristic Teens Might Use 
 

The reader must use TWO AI devices to help them get ready for school in the morning. One must 

be based on an emerging technology. The other gadget is your own futuristic invention. 

 

 Look at the Home category on your bubble map or research organizer from Session 1. 

What emerging AI tech can you include in the story to make the events seem realistic? 
  

  

  

 How will the reader use the futuristic gadget you invented to get ready for school? 

  

 

Create a 'Home of the Future' Slide 
 

1. Open your story in PowerPoint. 

2. From the Home tab, click the New Slide arrow. Pick Two Content. 

 

 
  

SA
MPLE



Session 2 

Copyright © TechnoKids Inc. 46 TechnoFuture AI 

Write the Story Events and Include Two AI Technologies 

You must write in 'second person narrative': 

• This style of writing makes the reader the main character in the story.

• Write sentences using the pronouns you, your, and yours. For example: You are fast asleep!

• Do not use the pronouns I, me, he, or she to refer to the main character.

• Second person narrative is the same style used in 'Choose Your Own Adventure'.

3. In the title box, type Home of the Future.

4. In one of the placeholders, type the beginning of your story.

• What happens in the morning when you get ready for school?

• How do you use emerging AI technology to make your morning routine easier?

• How does the reader use the futuristic gadget?

5. Type, It is now time for school as the final sentence.

 Story Writing Tips: 

• Consider the steps to get ready for school:

wake up, get out of bed, take a shower,

get dressed, have breakfast, talk to family.

• Think about technology that would make

the morning routine faster and easier.

• Remove the bullets from the text.

Insert an Image of the Futuristic Gadget 

6. Click the Pictures icon from the text placeholder. Select My Device.

7. Insert your saved image.

Use Designer to apply 

a professional-looking 

layout. 

Save Changes to the Story 

9. Save changes.
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Assignment 12 Control the Story Using Zoom 

A 'Choose Your Own Adventure' story has the reader decide what happens next by selecting 

from different options and turning to the corresponding page. In your case, there are no pages. 

Instead, the digital story has slides. 

 

To let readers advance to a specific slide you will use Zoom. Zoom adds an interactive button 

that links directly to a specific slide which smoothly transitions into view when clicked. It is ideal 

for non-linear storytelling. 

 

Here is what you will do: 

• Prevent the title slide from advancing when the mouse is clicked. 

• Use Zoom to insert a thumbnail of the Home of the Future slide. 

• Modify the thumbnail to an icon that guides the reader. 

• Test the story. 

 

 

Prevent the Title Slide from Advancing When the Mouse is Clicked 
 

1. Open your story in PowerPoint. View the title slide. 

2. Click the Transitions tab. Remove the checkmark On Mouse Click. 

 

 
 

Use Zoom to Link to the 'Home of the Future' Slide 
 

3. From the Insert tab, click Zoom. 

4. Select Slide Zoom. 

 

 

5. Select Home of the Future. Click Insert. 
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Change the Thumbnail Into A Suitable Icon 

6. From the Zoom tab, click Change Image.

7. Select From Icons.

8. Type in a keyword such as home, start, or story. Find an icon you like, then click Insert.

9. To format the icon:

a. From the Home tab, click Shape Fill and select an option.

b. From the Home tab, click Shape Outline and select an option.

Test the Story and Save the Changes to the Story 

10. From the Slide Show tab, click From Beginning.

11. Click anywhere on the title slide. NOTHING SHOULD HAPPEN!

NEED HELP? If you can click the mouse to show the next slide you need to change the timing. From 

the Transitions tab, remove the checkmark On Mouse Click. 

12. Click the button. For example:

The Home of the Future slide should show. 

ICON NOT WORKING? The background of an icon is transparent. To make it easier to click, 

from the Home tab, select Shape Fill and pick a solid color. 

13. Save changes.
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Session 2 Review About AI Image Generation 

About AI Image Generation 
 

1. What is Generative AI? 

 a. algorithms that can generate artificial intelligence 

 b. algorithms that create new content based on user input such as text or images 

 c. program that downloads images to a device 

 

2. What is AI image generation? 

 a. process where AI creates a new picture based on a prompt that describes the output 

 b. process where AI creates a story, poem, or script based on a text prompt 

 c. reference image that can be used to illustrate an idea 

 

3. What is the written description called that is used to create an AI generated image? 

 a. prompt engineering 

 b. visual prompt 

 c. text prompt 

/3 

 
 

Prompt Engineering Tips for Image Generation 

 

Select if the sentence is true or false. 
 

4. The text prompt should be a description of the setting or subject. True False 

    

5. The default style for all AI image generators is steam punk.  True False 

    

6. There is a limit on the adjectives you can use in a text prompt. True False 

    

7. You can specify the focal point to set the focus of the image. True False 

/4 

 
 

8. Pick 3 prompt engineering tips that can be used to create a clear, detailed, description. 

  use a maximum of 10 words to keep the description brief 

  use adjectives such as sleek, futuristic, or glowing 

  include details about an object such as the size, shape, color, or material 

  be vague to give the AI generator more creativity 

  specify the color palette such as pastel, monochrome, or neon 

  use subjective words such as awesome, epic, or original 

/3 
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Analyze the Text Prompt and Then Answer the Questions 

Here's the cartoon-style image of the cheerful teenage boy using the Dream3000 gadget 

to view a dream about a knight fighting a dragon. Let me know if you'd like any changes. 

Microsoft Copilot. (2025, July 4). Cartoon-style image of a teenage boy using the Dream3000 gadget to view a dream about a knight and a dragon 

[AI-generated image]. https://copilot.microsoft.com 

9. What is the word used to describe the mood?

a. cartoon

b. cheerful

c. dreams

10. What is the purpose of the futuristic gadget?

a. record and playback dreams

b. play a television show

c. dinner

11. What is the style of the image?

a. sketch

b. cartoon

c. anime

12. Does the output have the name of the gadget?

a. yes, the name is Dream3000

b. no, it has no name

13. What descriptor would show that the dream is a nightmare?

a. metallic sword

b. pop art bedroom

c. scared teenaged boy

/5 

TOTAL   /15 

Make an image in a cartoon style of a cheerful teenaged boy. He is wearing 

a gadget called Dream3000 that can record dreams. He is using the gadget 

to playback a dream about a knight fighting a dragon. The focal point 

should be the gadget. 

SA
MPLE

https://copilot.microsoft.com/


Session 2 

Copyright © TechnoKids Inc. 51 TechnoFuture AI 

Session 2 Skill Review Create a Gadget User Manual 

Create a user manual about the futuristic gadget you invented in Assignment 10. 

It will include instructions as well as troubleshooting tips.  

Organize Ideas for a User Manual 

1. What is the name of your futuristic gadget?

2. What does the gadget do?

3. Your gadget has a user interface. Describe the steps for using the device and its options.

4. Devices use software to tell the hardware what to do. Invent a name for the system software

or app that controls how the gadget works. How does the user do an update?

5. What problems might a person have when using the gadget? List 2 troubleshooting tips.

•

• 

Create a Digital Book Cover for the User Manual 

1. Open PowerPoint.

2. Type in a title such as Gadget User Manual.

3. In the subtitle box type a gadget description. Add By Student Name.

4. Select a design option:

a. From the Design tab, click Designer to generate suggestions.

b. Use your skills to temporarily add keywords to change the ideas.

c. Click on a design you like.

d. From the Design tab click the Variants arrow. Customize the color, font, or background.

For example: 

TIP: If PowerPoint automatically applies a 

design to a new presentation: 

• From the File menu, select Options.

• Select General.

• Clear the checkbox,

Automatically show me design ideas.

• Click OK.
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Add Instructions About the User Interface 
 

5. Create the user instructions: 

 
 a. From the Home tab, click the New Slide arrow. Pick Two Content. 

 b. In the title box, type Using the Device. 

 c. In one of the placeholders insert your AI generated image of the gadget. 
 

 d. In the other placeholder, explain how to use the device. 

 e. Select a professional design using Designer. 
 

 

 

 

 

 TIP: If you don't like the part of your image in view: 

• From the Picture Format tab, click Crop. 

• Drag the image left or right.  

• When done, click Crop again. 
 

 

 

6. Connect the digital book cover to the user instructions using Zoom: 

 a. View the title slide. Click the Transitions tab. Remove the checkmark On Mouse Click. 

 

 

 b. From the Insert tab, click Zoom. Select Slide Zoom.  TIP: Use Change Image on 

the Zoom tab to select an 

icon for the button.  
 c. Select Using the Device. Click Insert. 

7. Connect the Using the Device slide to the title slide. 
     

 

Add Troubleshooting Tips 
 

8. Create troubleshooting tips:  

 a. View Slide 2. From the Home tab, click the New Slide arrow. Pick Title and Content. 

 b. In the title box, type Troubleshooting. 

 

 c. In the placeholder type, IMPORTANT! If you are having 

problems with gadget, update the software. To do this... 

 d. Add your remaining troubleshooting tips. 

 9. Select a professional design using Designer. 

10. Connect the book cover to troubleshooting tips.  
    

 

Test the Design 
 

11. From the Slide Show tab, click From Beginning.  
 

 

12. Test the buttons: 

• Do buttons on the book cover go to the correct slides? 

• Can you return to the title slide using a button? 

• If you click anywhere on a slide, does it stay in view? 

13. Save the file. 
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Session 2 Extension Activity Discuss the Ethics of AI Artwork 

Consider the ethics of generating artwork using AI Image Generators. 

Intellectual Property Rights and AI 

Intellectual property rights are rules that protect people's original ideas and creations, like books, 

songs, artwork, and videos. Copyright is one type that gives the creator the right to control how 

their work is used. These rights make sure that the person who created something gets credit and 

can decide if others can copy, share, or change their work. Using someone else's work without 

permission or giving credit is unfair and sometimes even illegal. 

AI generators are trained by using large amounts of online content, including art, music, and 

writing. Often, the artists and creators of this work did not give permission to let their work be 

used. As a result, they do not get credit as the original artists or receive money for their work. 

If the artist is alive, they still have the rights to their work. They must agree to how others, such as 

AI companies, use their work for copying, sharing, or revising. If the artist has passed away, often 

their rights go to a family, estate, or foundation for many years after their death. Copyright still 

applies and anyone using their work needs to ask for permission. 

If you use an AI Image 

Generator to create an image 

based on your own original 

idea, you are not stealing from 

an artist.  

But, if you ask for an AI tool to 

produce artwork inspired by a 

specific artist, then it could 

infringe on their intellectual 

property rights. 

Original Artwork by Salvador Dali AI Generated Image in Dali’s Style 

By Salvador Dalí (1904-1989) - Image taken 

[http://0.tqn.com/d/arthistory/1/0/l/i/dali_moma_0708_11.jpg fromAbout.com], 

Fair use, https://en.wikipedia.org/w/index.php?curid=20132344 

Image created using Google Gemini text prompt: Create an image in the style 

of Salvador Dali’s The Persistence of Memory. Include melting clocks but set the 

background in a future landscape. 

Create an Image Inspired by a Popular Artist 

Apply your skills to generate an original image in an artist's style. Cite the source of the creation 

by asking the AI tool for a citation. For example, 'Can you give me the citation for this image?' 

Popular Artist's Styles that AI Image Generators Can Emulate 

Andy Warhol: pop art Pablo Picasso: cubist Beeple: futuristic 3D art Thomas Kincaid - luminous 

Keith Haring: cartoonish H.R. Giger: biomechanical Feng Zhu: sci-fi concept art Jack Kirby - superhero 

Hayao Miyazaki: anime Greg Rutkowski: fantasy Kim Jung Gi: sketch-based James Ng - steampunk 

1. Cite the source of the AI image you generated:

2. How does AI image generation support your personal creativity?

3. There are intellectual property laws to protect artists. Do you think using AI tools to emulate

an artist's style is stealing. Why or why not?
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How AI Models Steal Creative Work — And What To Do About It | Ed Newton-Rex 

Watch Ed Newton-Rex's Ted Talk about training AI, intellectual property rights, and solutions. 

4. What is the main theme of Ed Newton-Rex’s Ted Talk? 0:45 - 1:15

a. It is unfair and unsustainable to train AI models without paying creators or asking

permission to use their work.

b. It is too expensive for AI companies to train their models if they pay for licensed data.

c. AI companies would not exist without access to work by writers, musicians, and artists.

5. What do AI companies argue as a benefit to generative AI on society? 2:00 - 2:30

a. Generative AI is quick and easy to use.

b. Generative AI increases exposure to artists and their creative work.

c. Generative AI democratizes creativity, as it lets more people be creative.

6. Identify an artist that lost income when AI tools began to emulate their style? 3:30 - 4:00

a. Alex Small

b. Kelly McKernan

c. Hella Comat

7. Why do AI companies call the training of AI 'fair use' of creator's work? 4:58 - 5:40

a. It is 'fair' because some AI companies offer use of their tools for free.

b. Fair use copyright laws allow AI companies to create parodies of a work.

c. Making unlimited unlicensed copies of creative works is legal.

8. What is the solution posed by creators of original works for training AI models? 6:01 - 6:18

a. If a company wants to use copyrighted work, they can legally do so.

b. AI companies can make multiple copies of data they have scraped from the internet.

c. Creative work should be licensed and paid for when used to train AI models.

9. How can AI companies fairly train their models? 9:15 - 10:05

a. Only use training data that is in the public domain such as government documents.

b. Pay licensing fees for training data.

c. Share revenue with the creators of the data.

d. All of the above.

10. What proof does the speaker offer that licensing will not stifle innovation of AI? 10:00 - 10:30

a. Big companies have lots of money and can continue to be innovative.

b. Small start-ups are successfully licensing all their data using revenue shares.

c. All required data has already been scraped from the Internet to train AI models.

11. The Statement On AI Training is a letter that states generative AI models should not use

unlicensed works as it negatively affects the livelihoods of the original creators. 12:20 - 12:50

a. True

b. False

12. Using insights from the TED Talk and your own experiences, discuss the positive and

negative effects of generative AI on creators.

Pros Cons 

democratize creativity 

produce professional results quickly 

remix content and styles to create new ideas 

infringe on intellectual property rights 

AI competes with human creators 

creators may lose their livelihood 
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Session 6 Imagine Tomorrow 

 

Session 6 Imagine 
Tomorrow 

 

In this session, students prepare to unveil their imaginative, futuristic worlds to 

readers. They begin by testing the story’s flow, ensuring that each choice 

leads to the correct slide. Next, they enhance the storytelling experience by 

applying advanced animation techniques to keep readers fully engaged. 

Once their interactive story is complete, students share their 'Choose Your 

Own Adventure' file with others. They then read a classmate’s sci-fi story and 

leave a comment highlighting their favorite part. To wrap up the course, 

students reflect on their creative journey and the skills they have developed 

along the way. As an optional challenge, they can explore accessibility tools 

and apply design suggestions to make their story more inclusive. 

 

Assignment 30 Test the Interactive Story 

Assignment 31 Animate the Story Action 

Assignment 32 Share and Comment on Sci-Fi Stories 

 

Session 6 Review TechnoFuture AI Reflection 

Session 6 Extension Activity 1 Improve Accessibility 

Session 6 Extension Activity 2 Create a Printed Book 
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Session 6 Review TechnoFuture AI Reflection 

About the TechnoFuture AI Course 

1. Which parts of the course, TechnoFuture AI, did you like? Check all that apply.

 Imagine Tomorrow – envision the possibilities of emerging and futuristic AI technologies

 Write a Digital Story – create a 'Choose Your Own Adventure' sci-fi story in PowerPoint

 Use Generative AI Tools – generate content using artificial intelligence

 Code a Virtual Tutor – build a quiz that detects motion to answer questions using Scratch

 Analyze Videos – learn from experts by watching Ted Talks about artificial intelligence

 Collaborate with Peers – exchange ideas, share resources, or provide feedback

/1 

Generative AI and You 

2. In TechnoFuture AI, you used Generative AI tools to:

• research emerging and futuristic AI technologies

• brainstorm ideas

• generate images, 3D models, and music

• revise your writing to improve the text

How do you think you might use Generative AI tools in the future? 

/2 

3. What advice would you give someone about how to write an effective text prompt?

be specific, use descriptive words, ask an AI tool for suggestions to improve the text prompt

/1 

4. In what ways could Generative AI support or enhance your creativity?

Help to come up with new ideas when stuck.

Receive feedback on how to improve writing and then revise my own work.

Experiment with tools I am unfamiliar with or outside my skill set: visual arts, music

/2 

5. Generative AI tools can be supportive learning tools, but students should not rely on AI to

replace their thinking or efforts. It should not be used to 'cheat'.

Write three school rules that promote responsible and transparent use of these tools.

• acknowledge the use of generative ai tools by adding a disclosure statement

• 
cite the generative ai tool used to create content such as images; give credit to creators of the original when

generating derivative works

• submit versions of work for comparison including original text, ai text, and final work

/3 

6. Some creators worry that Generative AI might copy their work and affect their income.

How can understanding intellectual property rights help you make smart choices when

using or sharing content made with AI tools?
understand what content can or cannot be used, know how to credit the original creator, be a

responsible digital citizen, act fairly and respectfully, avoid legal trouble

/1
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Artificial Intelligence and You 

7. In your sci-fi story you included emerging and futuristic AI technologies such as:

• smart home gadgets to simplify daily life

• next-gen vehicles for travel that have AI safety features

• education tools that enhance learning and transform assignments

• workplace bots that can do a task quickly

• entertainment innovations that transform how people have fun

• cybersecurity measures that limit threats

Which AI technology from your story would you like to have right now? Why? 

/2 

8. List three things about AI that excite you most about the future.

•

• 

• 

/3 

9. List three concerns you have about the future of AI.

•

• 

• 

/3 

About Coding a Virtual Tutor 

10. What was your quiz about?

/1 

11. What did you find was the most difficult part of the coding assignment? Why?

/2 

12. The virtual tutor program allows students to select answers using hand gestures. How might

computer vision help break down barriers and make learning accessible to everyone?

Help people who have limited mobility or vision

/1 

Digital Storytelling and the Future 

13. How does a science fiction story, based on science facts, help people imagine or better

understand what the future might be like?
Help to envision what might be possible in the future, how problems might be solved, inspire new

inventions, consider the positive and negative effects of new ideas and technologies

/1 

14. You designed a non-linear digital story using PowerPoint's Zoom feature. How might you

apply this slide show format to another school task or presentation? List two ideas.

• interactive map, interactive quiz • student portfolio, digital museum, timeline

/2 

TOTAL:   /25 
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Refer to the appendices for additional resources: 

Appendix A Assessment Tools 

Appendix B Glossary 

Appendix C Contact Information SA
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Imagine Tomorrow Marking Sheet 

CONTENT 

Title Slide 

Design theme is appropriate for the story genre and topic. 

Title is creative and is suitable for a science fiction story. 

Title slide includes how-to instructions for the reader. /3 

Home of the Future 

Morning routine blends two AI technologies to depict a realistic home of the future. 

Story includes a futuristic AI gadget that helps a teen get ready for school. 

Story events are illustrated with an original AI-generated image of the futuristic gadget. /5 

Travel in the Future 

Futuristic vehicles include an AI-powered safety feature that helps the character. 

Reader has two vehicle choices for traveling to school (one vehicle option is from a peer). 

Story events are illustrated using an AI-generated 3D model of a futuristic vehicle. /5 

School of the Future 

School itinerary includes a description of four high-tech AI assignments organized using a table. 

Story events connect to the school itinerary. 

Itinerary includes a link to a Scratch quiz. /5 

Work in the Future 

Futuristic job has four AI-related tasks that are organized using a SmartArt graphic. 

Story events connect to the futuristic task list. 

Disclosure statement demonstrates transparency by documenting use of an AI tool to refine text. /5 

Entertainment in the Future 

Story events use artificial intelligence to transform socializing with friends into a futuristic activity. 

Story events are enhanced using original AI-generated music that fits the scene. 

Music automatically plays when slide is displayed. /5 

The End 

Slide informs the reader that the story has ended. 

WordArt is visually appealing. /2 

NAVIGATION 

Navigation buttons connect to the correct slides. 

Slide advancement is controlled using buttons; Mouse click is restricted. 

Zoom is used to link to slides; Buttons visually convey the meaning of each choice to the reader. 

An Action is used to end the slide show. /5 

ANIMATION 

Effects create visual interest and break up the story into chunks. 

Animations are sequenced in a logical order to guide the reader's focus. 

Timing of effects are suitable for the slide content.  

Animations automatically play. /5 

ORIGINALITY & WRITING STYLE 

Story is written in the style of 'Choose Your Own Adventure'. 

Second-person point of view engages the reader as the main character. 

Original and creative ideas in the story help the reader imagine the world of the future. 

Story includes additional content to enrich the plot (e.g., cybersecurity, detention, music) /10 

Total: /50 
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Virtual Tutor Marking Sheet 

CONTENT & DESIGN 

instructions clearly explain to the user how to take the test 

sprite acts as the virtual tutor 

quiz has 'True' and 'False' buttons used to select an answer 

timing of the questions is appropriate /4 

FUNCTIONALITY | How the Code Works 

camera automatically turns on to place the 'real world' onto the Scratch stage /1 

virtual tutor asks three 'True or False' questions about a topic /3 

'True or False' buttons appear when a question is asked and hide after the user selects an answer /3 

user answers questions by swiping their hand over 'True' and 'False' buttons /1 

camera detects motion over the 'True' and 'False'  buttons to allow the user to pick an answer /1 

answers are stored as variables (answer1, answer2, answer3) /3 

quiz correctly identifies whether the answer is 'True' or 'False'   /3 

virtual tutor informs the user if their answer is correct or incorrect /3 

SCORING 

score is stored as a variable /1 

score increases by 1 if the answer is correct for each question /3 

total score displays at the end of the quiz /1 

CREATIVITY 

quiz includes original elements such as sound, additional questions, or a custom backdrop /3 

Total: /30 SA
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